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Characteristics and Outcomes Site Profiles Report Guide 

(GAIN-Q3) 

____________________________________________________ 
 

Overview  
The Characteristics and Outcomes Site Profiles Report provides our customers within a given 

treatment agency a comprehensive description of the baseline and follow up circumstances of clients 

that are assessed using the GAIN family of instruments at a treatment agency. The report uses the 

GAIN Intake (GAIN-I), GAIN Monitoring 90 days (GAIN-M90), and GAIN-Q3 assessments that are 

submitted to Chestnut Health Systems and provides both baseline and preliminary outcome charts. 

This is a cumulative report that includes all GAIN assessments that are conducted by each agency 

and submitted to Chestnut Health Systems and continues to build through the life of the project. Our 

goal in creating this report for each project is to provide each site with descriptive information in a 

user-friendly format regarding baseline participant use patterns, participant demographics, violence 

and crime, social economic status, as well as preliminary outcome measures.  

 

There are three versions of the GAIN-Q3:  

 

 GAIN-Q3-Lite: This is the most basic form of the assessment. It consists of nine screeners 

that estimate the severity of problems and recency of treatment participation in each life area 

represented.  

 

 GAIN-Q3-Standard: This version contains the same nine screeners as the GAIN-Q3-Lite, 

plus additional items that record information on the frequency of participants’ service 

utilization and behaviors during the preceding 90 days. The GAIN-Q3-Standard provides 

more detailed outcome measures than the GAIN-Q3-Lite, and the additional information can 

be used to monitor participants’ progress when the Q3 is used as a follow-up assessment. In 

addition to the quality of life measure, the GAIN-Q3-Standard computes indices on the 

participant’s prevalence of problems and quarterly costs to society. A six-item measure on 

current life satisfaction is also included.  

 

 GAIN-Q3-MI: This version is best suited to participants who may be in need of brief 

intervention. It contains the same nine screeners as the GAIN-Q3-Lite and Standard, the past-

90-day items, and the measure of life satisfaction from the Q3-Standard, as well as reasons 

and readiness items to facilitate a motivational-interviewing session.  

 

Click here for additional information on the GAIN-Q3 assessment.  

 

http://www.gaincc.org/index.cfm?pageID=51
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Functionality  
 

Before opening the file, please ensure the Security setting for Microsoft Excel is set no higher than 

Medium in order to successfully enable the macros to generate the charts and graphs located within 

this document. Depending on the version of Microsoft Office you are running, the macro security 

setting can be verified or updated by doing the following:  

 

 Excel 2010 – Navigate to the Developer tab. If you do not see the Developer tab, go to 

FileOptionsCustomize Ribbon, and check the Developer field on the right hand side. Hit 

OK.  

o Once on the Developer tab, choose the Macro Security button. This will bring up the 

Trust Center options. 

o Under Macro Settings, choose to Enable all macros. Hit OK.  

o You will then need to close out of Excel completely and re open the file for this    

     change to take place.  

 Excel 2007 - Navigate to the Developer tab. If you do not see the Developer tab, click on the 

Microsoft Office button, then choose Excel Options. Click on Popular, and check Show 

Developer tab in the Ribbon. Hit OK.  

o Once on the Developer tab, choose the Macro Security button. This will bring up the  

     Trust Center options.  

o Under Macro Settings, choose to Enable all macros. Hit OK.  

o You will then need to close out of Excel completely and re open the file for this  

     change to take place.  

 Excel 2003 – Navigate to the Tools tab.  

   o Choose MacroSecurity.  

   o Update the security level to Low.  

   o You will then need to close out of Excel completely and re open the file for this  

change to take place.  

 

Next, ensure both the Excel file and the PowerPoint template are saved in the same location. This 

facilitates the conversion to PowerPoint which will be explained in more detail below in the 

“Transferring Site Profiles into Microsoft PowerPoint” section of this guide.  
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Report Contents  
 

The Site Profiles Report consists of five tabs: Title, Chart Options, Table of Contents, Data, and 

References. The following information will briefly describe the contents and functionality of each 

tab:  

 

Title  

 

The Site Profiles Report opens on the Title tab. This tab contains information regarding the Site 

Profiles such as the creation date and the names of all sites involved in the project. Chestnut Health 

Systems’ contact information is also included on this tab.  

 

Chart Options  

 

The Chart Options tab (Figure 1) provides a feature containing drop down boxes that allow for 

selection of single site data or the total to be represented in a series of charts showing a single site's 

data. Both drop-down menus contain every site that is a part of the grant or project along with the 

total across all sites. In addition to selecting a specific site, a second site or total may be selected to 

be represented in a series of charts comparing the two groups. The sites selected are identified in the 

legend of each of these charts.  

 

 
FIGURE 1: CHART OPTIONS  
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Table of Contents  
 

The Table of Contents tab (Figure 2) contain links that when selected generate charts based on the 

choices selected in the Chart Options tab. To select a chart, click once on the “Select a Chart to 

View” link, then click the down arrow that appears. This shows a drop down menu that lists all charts 

for that category. Then, click once on the desired chart name to view that chart. 

 

 
FIGURE 2: TABLE OF CONTENTS 

 

The first column contains Client Characteristics and Performance measures and Cross Domain 

Measures, Outcomes, and Follow Up Charts for both Single Sites and Site Comparisons. "Single Site 

Charts" contain site-specific information for the Site or Overall Total selected on the Chart Options 

tab. Some examples include Race Groups, Age Groups, and Performance Rates. "Comparison 

Charts" will compare one agency to another agency or to the overall total for the project. A few 

examples include Demographics, Intake Screening Index, and Treatment Course. Cross Domain 

Measures and Outcomes charts contain single site information. Some examples include Life Impact 

Measures, Cost to Society by Cohort, School Problems and Substance Use Problems. The Follow Up 

Charts will show various follow up rates for both the selected site and a two-site comparison.  

 

The remaining columns contain charts that list a series of GAIN-Q3 Scales in various areas, 

including School, Work, Physical Health, Sources of Stress, Risk Behavior, Mental Health, 

Substance Use, and Crime and Violence. Within these areas are a number of charts displaying 

Problem and Intervention charts for both single-site and two-site figures. The Motivational 
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Interviewing (MI) Site Profile will also include charts displaying Reasons for Change and MI 

Administration Criteria.  

 

There is a section titled Show and Hide All Charts, which allow the user to view all charts for the 

sites listed in the Chart Options tab. By selecting “Show All Charts”, each individual chart will be 

shown on a new sheet on a separate tab named Charts_All. On the Charts_All tab, there are links at 

the top left corner referring to the different chart categories. To navigate to a certain chart, click on 

the link for the category for that chart, and then scroll to the right to view it. For example, to navigate 

to the “Intake Screening – All Admissions” chart, first click the “Cross Domain Measures” link, then 

scroll right to find the “Intake Screening – All Admissions” chart. To return to the top of the 

Charts_All page, scroll left and click the “Return to top of page” link.  To return to the Chart Options 

or Table of Contents tabs, click the “Back to Chart Options” or “Back to Table of Contents” link. 

The “Hide All Charts” link on the Table of Contents tab will remove the Charts_All tab and return 

the report to its original format.  

 

There is also an Export Options section at the lower portion of the Table of Contents tab that has a 

button that will generate a PowerPoint presentation. This will be explained in more detail below in 

the “Transferring Site Profiles into Microsoft PowerPoint” section of this guide.  

 

Data  

 

The fourth tab, titled “Data”, contains all the data used to generate the charts in the Site Profiles.  

 

NOTE: There is additional data in this tab that is not depicted in the charts. Please refer to this tab if 

there is any additional information needed that is not specified in the “Table of Contents” tab. This 

tab is also helpful for locating similar sites and selecting them in the Chart Options tab for further 

comparison in the generated charts.  

 

References  

 

The final tab is the References tab, which is a compilation of all measurement references used to 

create the report.  

 

Chart Descriptions  

 
The report includes calculated scales and indices that are used to generate individual site charts and 

comparison charts that enable an agency to view all of their client GAIN information. Each site 

included is able to review how their site is performing in key performance indicators as well as see 

charts depicting their clients’ intake and preliminary follow up statuses. This report also provides the 

ability to compare sites to each other as well as to the total across all agencies within a project. The 

report provides all of the sites with graphical depiction of demographics, substance use trends, and 

treatment history.  

 
NOTE: The chart descriptions listed below describe charts included in the GAIN-Quick Motivational Interviewing 

Site Profile. The GAIN-Q3 Lite and Standard versions will not include all charts described below.  

 

The first column in the Table of Contents tab lists charts that contain both single site and comparison 

information. The following is a list and brief description of each chart.  
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Single Site Charts 

 

1. Gender: The Gender chart shows the percentage of clients within the study that are male 

or female.  

 

2. Race Groups: The Race Groups chart breaks down what percentages of clients within the  

       study are in each race group below:  

 American Indian/Alaska Native  

 Asian  

 African American/Black  

 Caucasian/White  

 Hispanic  

 Multiracial  

 Other  

 

3. Age groups: The Age Groups chart shows the percentages of clients within the study are 

in each age group below:  

 Less than 15 years  

 15-17 years  

 18+ years  

 

4. Environment: The Environment chart lists the percentage of clients in the following 

living situations:  

 In School  

 Employed  

 

5. Performance Rates: The Performance Rates chart shows the percentages of different rates 

at the site:  

 Recruitment Percentage  

 TxSI Completion Percentage  

 3 Month FU Rate Percentage  

 6 Month FU Rate Percentage  

 12 Month FU Rate Percentage  

 

6. Unresolved GAIN Edits: The Unresolved GAIN Edits chart shows the percentage of 

GAIN Edits that need to be addressed.  

 

The second section in the first column of the Table of Contents tab lists charts that compare two sites 

or one site against the total across all sites, depending on the options selected in the Chart Options 

tab. The comparison charts have been designed to be an educational tool to analyze treatment 

provided and present preliminary outcome measures. It should be noted that some of the categories 

used in the single site charts have been combined for research purposes and ease of viewing in the 

two site comparison charts. For a narrower comparison, an agency with similar characteristics and 

provided services (based on characteristics and services portion of the report) can be selected from 

the Chart Options tab. The following is a list and brief description of each comparison chart.  
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Comparison Charts 

 

1. Demographics: The Demographics chart shows side-by-side comparisons between two sites 

in regards to the following demographic categories: 

 Male  

 Female  

 Minority status  

 American Indian/Alaska Native  

 Asian  

 African American/Black  

 Caucasian/White  

 Hispanic  

 Multiracial  

 Other  

 Less than 15 years  

 15-17 years  

 18+ years  

 

2. Environment: The Environment chart compares the percentage of clients in the following 

living situations:  

 In school  

 Employed  

 

3. Intake Screening All: The Intake Screening – All Admissions chart compares the percentage 

of clients in regards to where they came from and what level of treatment they assigned to 

between the two sites chosen in the Chart Options tab:  

 Coming From  

o From Community  

o From Outpatient  

o From Juvenile Justice  

o From Other Placement  

o Assigned to OP/IOP  

o Assigned to ST/MT/LT Res  

o Assigned to Other  

 

4. Intake Screening Index: The Intake Screening – Index Admission chart compares the 

percentage of clients in regards to where they came from on their Index Admission and what 

level of treatment they would be assigned to between the two sites chosen in the Chart 

Options tab:  

 Coming From  

o From Community  

o From Outpatient  

o From Juvenile Justice  

o From Other Placement  

o Assigned to OP/IOP  
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o Assigned to ST/MT/LT Res  

o Assigned to Other  

 

5. Treatment Course: The Treatment Course chart compares the percentage of participants in 

regards to varying lengths of stay and different discharge statuses between the two sites 

chosen in the Chart Options tab:  

 Length of Stay  

o Still in Treatment  

o Less than 30 days  

 

o 30-89 days  

o 90 or more days  

 Discharge Status  

o Completion – Discharged to Community  

o AMA/ASR  

o Transfer to further Substance Abuse treatment  

o Transfer to CJ agency  

o Other  

 

6. Performance Rates: The Performance Rates chart compares the percentage of different rates 

between the two sites chosen in the Chart Options tab including recruitment and follow-up:  

 Recruitment Percentage  

 TxSI Completion Percentage  

 3 Month FU Rate Percentage  

 6 Month FU Rate Percentage  

 12 Month FU Rate Percentage  

 

7. Unresolved GAIN Edits: The Unresolved GAIN Edits chart compares the percentage of 

GAIN Edits that need to be addressed between two sites.  

 

Cross Domain Measures, Outcomes, and Follow Up 

 

The first category in the second column, titled Cross Domain Measures, contains charts with single-

site information regarding various measures.  

 

1. Life Impact Measures: The Life Impact Measure chart shows where clients fall in the 

following areas in terms of problematic (low, moderate and high) and beneficial (high, 

moderate and low):  

 Problem Prevalence Index  

 Quarterly Cost to Society  

 Life Satisfaction Index  

 Quality of Life Index  

 

2. Cost to Society/Cohort: The Cost to Society by Cohort chart shows the cost impact both to 

society and the agency during the past 90 days:  

 Quarterly Cost to Society  

 Yearly Cost to Society  



9 
 

 Quarterly Cost to Agency  

 Yearly Cost to Agency  

3. GAIN Placement Cells by GAIN-Q3 Problem Area: The GAIN Placement Cells by GAIN-

Q3 Problem Area chart shows the percentage of problem severity based on the following 

GAIN-Q3 specified problem areas:  

 School  

 Work  

 Health Problems  

 Stress  

 Risk Behaviors  

 Internal Disorders  

 External Disorders  

 Substance Disorders  

 

The second category in the second column, titled Outcomes – Past 90 Days, contains charts with 

single-site information regarding outcomes based on the past 90 days.  

 

1. School Problems: The School Problems chart shows the percentage of participants in the low, 

medium, and high range on the grouped past 90 day Substance Problems Scale at intake, 3-

month, 6-month, and 12-month follow-up.  

 

2. Work Problems: The Work Problems chart shows the percentage of participants in the low, 

medium, and high range on the grouped past 90 day Work Problems Scale at intake, 3-month, 

6-month, and 12-month follow-up.  

 

3. Physical Health Problems: The Physical Health Problems chart shows the percentage of 

participants in the low, medium, and high range on the grouped past 90 day Physical Health 

Problems Scale at intake, 3-month, 6-month, and 12-month follow-up.  

 

4. Sources of Stress Problems: The Sources of Stress Problems chart shows the percentage of 

participants in the low, medium, and high range on the grouped past 90 day Sources of Stress 

Problems Scale at intake, 3-month, 6-month, and 12-month follow-up.  

 

5. Risk Behavior Problems: The Risk Behavior Problems chart shows the percentage of 

participants in the low, medium, and high range on the grouped past 90 day Risk Behavior 

Problems Scale at intake, 3-month, 6-month, and 12-month follow-up.  

 

6. Mental Health Problems – Internalizing: The Mental Health Problems (Internalizing) chart 

shows the percentage of participants in the low, medium, and high range on the grouped past 

90 day Mental Health Problems Scale at intake, 3-month, 6-month, and 12-month follow-up.  

 

7. Mental Health Problems – Externalizing: The Mental Health Problems (Externalizing) chart 

shows the percentage of participants in the low, medium, and high range on the grouped past 

90 day Mental Health Problems Scale at intake, 3-month, 6-month, and 12-month follow-up.  

 

8. Crime and Violence Problems: The Risk Behavior Problems chart shows the percentage of 

participants in the low, medium, and high range on the grouped past 90 day Risk Behavior 

Problems Scale at intake, 3-month, 6-month, and 12-month follow-up.  
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Follow-Up Charts 

  

The third category in the second column, titled Follow Up Charts, contains charts that display sample 

sizes and follow-up rates:  

 
1. Sample Size & GAIN FU Rate - All: The Sample Size & GAIN FU Rates – All chart 

displays the sample sizes of each interview wave and the GAIN follow-up rates for every 

agency.  

 

2. Sample Size & GAIN FU Selected: The Sample Size & GAIN FU Selected Sites chart 

displays the sample sizes of each interview wave and the GAIN follow-up rates for the two 

sites selected in the Chart Options tab.  

 

GAIN-Q3 Scales 

 

The remaining columns, titled GAIN-Q3 Scales, contain a series of charts for various problem areas, 

including School, Work, Physical Health, Sources of Stress, Risk Behavior, Mental Health, 

Substance Use and Crime and Violence. Within these areas are a number of charts displaying 

Problem and Intervention charts for both single-site and two-site comparisons. The Motivational 

Interviewing (MI) Site Profile will include charts displaying Reasons for Change and MI 

Administration Criteria.  

 

NOTE: Percentages are based on the percentage of clients who answered the questions for that 

specific section. The percentage of clients is displayed on the charts as a reference.  

 

School  

 

1. School Problems – Single Site: The School Problems – Single Site chart shows the 

percentage of clients in the low, medium, and high range in the following areas: 

 Recency of School Problems  

 School Problem Screener – Lifetime  

 School Problem Screener – Past Year  

 School Problem Screener – Past 90 Days  

 School Problem Screener – Past Month  

 Days Absent from School  

 

2. School Intervention – Single Site: The School Intervention – Single Site chart shows the 

percentage of clients in the low, medium, and high range in the following areas:  

 Recency of School-Related Intervention  

 Days of School-Related Intervention  

 Reasons for School-Related Change  

 Readiness for School-Related Change  

 

3. School Problems – GAIN Placement Cell: The School Problems – GAIN Placement Cell 

chart shows the percentage of problem severity in relation to school problems.  
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4. School Problems – Site Comparisons: The School Problems – Site Comparisons chart 

compares the percentage of clients in the low, medium, and high range included in the 

School Problems – Single Site chart.  

 

5. School Intervention – Site Comparisons: The School Intervention – Site Comparisons chart 

compares the percentage of clients in the low, medium, and high range included in the 

School Intervention – Single Site chart.  

 

6. Reasons for Change – School Problems: (Motivational Interviewing Only) The Reasons for 

Change Related to School Problems chart shows the percentage of clients that responded 

with the following reasons for change:  

 To do better in school or training  

 So you will get better grades  

 So won’t get in trouble in school  

 So won’t get expelled  

 So others will stop bothering you about your school problems  

 So you can get your diploma/better paying job  

 

7. Motivational Interviewing Administration Criteria – School Problems: (Motivational 

Interviewing Only) The School Problems Motivational Interviewing Administration Criteria 

chart shows the percentage of GAIN administration problems:  

 No Problems – Agreed  

 GAIN – Problems, Staff Override  

 GAIN – No Problems, Staff Override  

 Problems – Agreed  

 

Work  

 

1. Work Problems – Single Site: The Work Problems – Single Site chart shows the percentage 

of clients in the low, medium, and high range in the following areas:  

 Recency of Work Problems  

 Work Problem Screener – Lifetime  

 Work Problem Screener – Past Year  

 Work Problem Screener – Past 90 Days  

 Work Problem Screener – Past Month  

 Days Absent from Work  

 

2. Work Intervention – Single Site: The Work Intervention – Single Site chart shows the 

percentage of clients in the low, medium, and high range in the following areas:  

 Recency of Work-Related Intervention  

 Days of Work-Related Intervention  

 Reasons for Work-Related Change  

 Readiness for Work-Related Change  

 

3. Work Problems – GAIN Placement Cell: The Work Problems – GAIN Placement Cell chart 

shows the percentage of problem severity in relation to Work problems.  
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4. Work Problems – Site Comparisons: The Work Problems – Site Comparisons chart compares 

the percentage of clients in the low, medium, and high range included in the Work Problems 

– Single Site chart.  

 

5. Work Intervention – Site Comparisons: The Work Intervention – Site Comparisons chart 

compares the percentage of clients in the low, medium, and high range included in the Work 

Intervention – Single Site chart.  

 

6. Reasons for Change – Work Problems: (Motivational Interviewing Only) The Reasons for 

Change Related to Work Problems chart shows the percentage of clients that responded with 

the following reasons for change:  

 So you will get more work done  

 To receive better evaluations  

 So you won’t get into trouble  

 So you won’t get fired  

 So others will stop bothering you about your work problems  

 You can continue providing for yourself (and your family)  

 

7. Motivational Interviewing Administration Criteria – Work Problems: (Motivational 

Interviewing Only) The Work Problems Motivational Interviewing Administration Criteria 

chart shows the percentage of GAIN administration problems:  

 No Problems – Agreed  

 GAIN – Problems, Staff Override  

 GAIN – No Problems, Staff Override  

 Problems – Agreed  

 

Physical Health  

 

1. Physical Health Problems – Single Site: The Physical Health Problems – Single Site chart 

shows the percentage of clients in the low, medium, and high range in the following areas:  

 Recency of Physical Health Problems  

 Health Problem Screener – Lifetime  

 Health Problem Screener – Past Year  

 Health Problem Screener – Past 90 Days  

 Health Problem Screener – Past Month  

 Days of Physical Health Problems  

 

2. Physical Health Intervention – Single Site: The Physical Health Intervention – Single Site 

chart shows the percentage of clients in the low, medium, and high range in the following 

areas: 

 Recency of Physical Treatment  

 Days of Physical Health Treatment  

 Reasons for Physical Health-Related Change  

 Readiness for Physical Health-Related Change  
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3. Physical Health Problems – GAIN Placement Cell: The Physical Health Problems – GAIN 

Placement Cell chart shows the percentage of problem severity in relation to Physical Health 

problems.  

 

4. Physical Health Problems – Site Comparisons: The Physical Health Problems – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Physical Health Problems – Single Site chart.  

 

5. Physical Health Intervention – Site Comparisons: The Physical Health Intervention – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Physical Health Intervention – Single Site chart.  

 

6. Reasons for Change – Physical Health Problems: (Motivational Interviewing Only) The 

Reasons for Change Related to Physical Health Problems chart shows the percentage of 

clients that responded with the following reasons for change:  

 So you will feel better  

 To stop worrying about your health  

 To participate in more activities  

 To get more done  

 So you won’t be in pain  

 So others will stop bothering you about your health problems  

 

7. Motivational Interviewing Administration Criteria – Physical Health Problems: 

(Motivational Interviewing Only) The Physical Health Problems Motivational Interviewing 

Administration Criteria chart shows the percentage of GAIN administration problems:  

 No Problems – Agreed  

 GAIN – Problems, Staff Override  

 GAIN – No Problems, Staff Override  

 Problems – Agreed  

 

Sources of Stress  

 

1. Sources of Stress Problems – Single Site: The Sources of Stress Problems – Single Site chart 

shows the percentage of clients in the low, medium, and high range in the following areas:  

 Recency of Stress Problems  

 Sources of Stress Screener – Lifetime  

 Sources of Stress Screener – Past Year  

 Sources of Stress Screener – Past 90 Days  

 Sources of Stress Screener – Past Month  

 Days of Financial Problems and Other Stress  
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2. Sources of Stress Intervention – Single Site: The Sources of Stress Intervention – Single Site 

chart shows the percentage of clients in the low, medium, and high range in the following 

areas:  

 Recency of Stress-Related Intervention  

 Days of Stress-Related Intervention  

 Reasons for Stress-Related Change  

 Readiness for Stress-Related Change  

 

3. Sources of Stress Problems – GAIN Placement Cell: The Sources of Stress Problems – GAIN 

Placement Cell chart shows the percentage of problem severity in relation to Sources of 

Stress problems.  

 

4. Sources of Stress Problems – Site Comparisons: The Sources of Stress Problems – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range on 

the grouped past 90 day Sources of Stress Problems Scale included in the Sources of Stress 

Problems – Single Site chart.  

 

5. Sources of Stress Intervention – Site Comparisons: The Sources of Stress Intervention – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Sources of Stress Intervention – Single Site chart.  

 

6. Reasons for Change – Sources of Stress Problems: (Motivational Interviewing Only) The 

Reasons for Change Related to Sources of Stress Problems chart shows the percentage of 

clients that responded with the following reasons for change:  

 To feel better or more relaxed  

 To learn how to deal with problems in a healthy way  

 So you won’t feel anxious all the time  

 So you won’t be irritable  

 To sleep better  

 To get more done  

 

7. Motivational Interviewing Administration Criteria – Sources of Stress Problems: 

(Motivational Interviewing Only) The Sources of Stress Problems Motivational 

Interviewing Administration Criteria chart shows the percentage of GAIN administration 

problems:  

 No Problems – Agreed  

 GAIN – Problems, Staff Override  

 GAIN – No Problems, Staff Override  

 Problems – Agreed  

 

 

 

 

 

 



15 
 

Risk Behavior  

 

1. Risk Behavior Problems – Single Site: The Risk Behavior Problems – Single Site chart 

shows the percentage of clients in the low, medium, and high range in the following areas:  

 Recency of Risk Problems  

 Risk Problem Screener – Lifetime  

 Risk Problem Screener – Past Year  

 Risk Problem Screener – Past 90 Days  

 Risk Problem Screener – Past Month  

 Days of Risk Behaviors  

 

2. Risk Behavior Intervention – Single Site: The Risk Behavior Intervention – Single Site chart 

shows the percentage of clients in the low, medium, and high range in the following areas:  

 Recency of Risk-Related Intervention  

 Days of Risk-Related Intervention  

 Reasons for Risk-Related Change  

 Readiness for Risk-Related Change  

 

3. Risk Behavior Problems – GAIN Placement Cell: The Risk Behavior Problems – GAIN 

Placement Cell chart shows the percentage of problem severity in relation to Risk Behavior 

problems.  

 

4. Risk Behavior Problems – Site Comparisons: The Risk Behavior Problems – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Risk Behavior Problems – Single Site chart.  

 

5. Risk Behavior Intervention – Site Comparisons: The Risk Behavior Intervention – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Risk Behavior Intervention – Single Site chart.  

 

6. Reasons for Change – Risk Behavior Problems: (Motivational Interviewing Only) The 

Reasons for Change Related to Risk Behavior Problems chart shows the percentage of clients 

that responded with the following reasons for change:  

 To keep from getting HIV or illness  

 Don’t want to be in a situation where you could be hurt  

 Don’t want negative impact on family  

 Don’t want to be responsible for spreading disease  

 Don’t want to die before your time  

 These behaviors make you look bad  

 

7. Motivational Interviewing Administration Criteria – Risk Behavior Problems: (Motivational 

Interviewing Only) The Risk Behavior Problems Motivational Interviewing Administration 

Criteria chart shows the percentage of GAIN administration problems:  

 No Problems – Agreed  

 GAIN – Problems, Staff Override  
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 GAIN – No Problems, Staff Override  

 Problems – Agreed 

 

Mental Health  

 

1. Internalizing Problems – Single Site: The Mental Health Problems – Internalizing – Single 

Site chart shows the percentage of clients in the low, medium, and high range in the 

following areas:  

 Recency of Internalizing Disorder – Problems  

 Internalizing Disorder Problem Screener – Lifetime  

 Internalizing Disorder Screener – Past Year  

 Internalizing Disorder Screener – Past 90 Days  

 Internalizing Disorder Screener – Past Month  

 Days of Internalizing Disorder Problems  

 

2. Externalizing Problems – Single Site: The Mental Health Problems – Externalizing – Single 

Site chart shows the percentage of clients in the low, medium, and high range in the 

following areas:  

 Recency of Externalizing Disorder – Problems  

 Externalizing Disorder Problem Screener – Lifetime  

 Externalizing Disorder Screener – Past Year  

 Externalizing Disorder Screener – Past 90 Days  

 Externalizing Disorder Screener – Past Month  

 Days of Externalizing Disorder Problems  

 

3. Mental Health Intervention – Single Site: The Mental Health Intervention – Single Site chart 

shows the percentage of clients in the low, medium, and high range in the following areas:  

 Recency of Mental Health Treatment  

 Days of Mental Health Treatment  

 Reasons for Mental Health-Related Change  

 Readiness for Mental Health-Related Change  

 

4. Mental Health Problems – GAIN Placement Cell: The Mental Health Problems – GAIN 

Placement Cell chart shows the percentage of problem severity in relation to Mental Health 

problems.  

 

5. Internalizing – Site Comparisons: The Mental Health – Internalizing – Site Comparisons 

chart compares the percentage of clients in the low, medium, and high range included in the 

Internalizing Problems – Single Site chart.  

 

6. Externalizing – Site Comparisons: The Mental Health – Externalizing – Site Comparisons 

chart compares the percentage of clients in the low, medium, and high range included in the 

Externalizing Problems – Single Site chart.  
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7. Mental Health Intervention – Site Comparisons: The Mental Health Intervention – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Mental Health Intervention – Single Site chart.  

 

8. Reasons for Change – Mental Health Problems: (Motivational Interviewing Only) The 

Reasons for Change Related to Mental Health Problems chart shows the percentage of clients 

that responded with the following reasons for change:  

 To feel better  

 To get more things done  

 To be able to move forward with life  

 To be able to concentrate better  

 So energy will improve  

 To be able to think more clearly  

 Don’t want problems to have negative impact on family  

 Your family wants you to get help  

 To avoid having problems with other people  

 Don’t want to get in trouble  

 

9. Motivational Interviewing Administration Criteria – Mental Health Problems: (Motivational 

Interviewing Only) The Mental Health Problems Motivational Interviewing Administration 

Criteria chart shows the percentage of GAIN administration problems:  

 No Problems – Agreed  

 GAIN – Problems, Staff Override  

 GAIN – No Problems, Staff Override  

 Problems – Agreed  

 

Substance Use  

 

1. Substance Use Problems – Single Site: The Substance Use Problems – Single Site chart 

shows the percentage of clients in the low, medium, and high range in the following areas: 

 Recency of Substance Use Problems  

 Substance Disorder Screener – Lifetime  

 Substance Disorder Screener – Past Year  

 Substance Disorder Screener – Past 90 Days  

 Substance Disorder Screener – Past Month  

 Days of Alcohol Intoxication or 5+ drinks  

 Days of Other Drug Use  

 Days of Substance Use 90 days prior to controlled environment  

 

2. Substance Use Intervention – Single Site: The Substance Use Intervention – Single Site chart 

shows the percentage of clients in the low, medium, and high range in the following areas:  

 Recency of Substance Use Treatment  

 Days of Substance Use-Related Services  
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 Days in a Controlled Environment  

 Days of Self Help  

 Reasons for Substance-Related Change  

 Readiness for Substance-Related Change  

 

3. Substance Use Problems – GAIN Placement Cell: The Substance Use Problems – GAIN 

Placement Cell chart shows the percentage of problem severity in relation to Substance Use 

problems.  

 

4. Substance Use Problems – Site Comparisons: The Substance Use Problems – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Substance Use Problems – Single Site chart.  

 

5. Substance Use Intervention – Site Comparisons: The Substance Use Intervention – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Substance Use Intervention – Single Site chart.  

 

6. Reasons for Change – Substance Use Problems: (Motivational Interviewing Only) The 

Reasons for Change Related to Substance Use Problems chart shows the percentage of clients 

that responded with the following reasons for change:  

 Don’t like the way it makes you feel  

 To get life on a better path  

 Alcohol and drugs are hurting your body  

 Under legal pressure to quit  

 Family, friends or kids want you to quit  

 You want to keep your children  

 Don’t want to get in trouble at work  

 Don’t want to get in trouble with the law  

 It costs too much money  

 

7. Motivational Interviewing Administration Criteria – Substance Use Problems: (Motivational 

Interviewing Only) The Substance Use Problems Motivational Interviewing Administration 

Criteria chart shows the percentage of GAIN administration problems:  

 No Problems – Agreed  

 GAIN – Problems, Staff Override  

 GAIN – No Problems, Staff Override  

 Problems – Agreed  

 

Crime and Violence  

 
1. Crime and Violence Problems – Single Site: The Crime and Violence Problems – Single Site 

chart shows the percentage of clients in the low, medium, and high range in the following 

areas:  

 Recency of Crime and Violence Problems  

 Crime/Violence Problem Screener – Lifetime  
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 Crime/Violence Problem Screener – Past Year  

 Crime/Violence Problem Screener – Past 90 Days  

 Crime/Violence Problem Screener – Past Month  

 Days of Arguing/Violence Towards Others  

 Days of Illegal Activity  

 

2. Crime and Violence Intervention – Single Site: The Crime and Violence (Justice System 

Intervention) – Single Site chart shows the percentage of clients in the low, medium, and 

high range in the following areas:  

 Recency of Justice System Involvement  

 Days of Justice System Involvement  

 Times Arrested in Past 90 Days  

 Reasons for Crime/Violence-Related Change  

 Readiness for Crime/Violence-Related Change  

 

3. Crime and Violence Problems – GAIN Placement Cell: The Crime and Violence Problems – 

GAIN Placement Cell chart shows the percentage of problem severity in relation to Crime 

and Violence problems.  

 

4. Crime and Violence Problems – Site Comparisons: The Crime and Violence Problems – Site 

Comparisons chart compares the percentage of clients in the low, medium, and high range 

included in the Crime and Violence Problems – Single Site chart.  

 

5. Crime and Violence Intervention – Site Comparisons: The Crime and Violence Intervention – 

Site Comparisons chart compares the percentage of clients in the low, medium, and high 

range included in the Crime and Violence Intervention – Single Site chart.  

 

6. Reasons for Change – Crime and Violence Problems: (Motivational Interviewing Only) 

The Reasons for Change Related to Crime and Violence Problems chart shows the 

percentage of clients that responded with the following reasons for change:  

 Don’t want to get in trouble with the law  

 Your family and friends want you to stop  

 You want your life on a better path  

 Crime and violent behavior are wrong  

 

7. Motivational Interviewing Administration Criteria – Crime and Violence Problems: 

(Motivational Interviewing Only) The Crime and Violence Problems Motivational 

Interviewing Administration Criteria chart shows the percentage of GAIN administration 

problems:  

 No Problems – Agreed  

 GAIN – Problems, Staff Override  

 GAIN – No Problems, Staff Override  

 Problems – Agreed  
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Transferring Site Profiles into Microsoft PowerPoint  
We have also provided an option to export the Site Profiles report into a PowerPoint presentation. At 

the bottom of the “Table of Contents” tab is an Export Options section. The “Generate PowerPoint 

Presentation” button will create a PowerPoint presentation containing each chart in the Site Profiles. 

Once the button is selected, PowerPoint will automatically open and every chart will be copied and 

pasted into a new PowerPoint presentation. Once all the charts have been transferred to PowerPoint, 

Excel will automatically close and the PowerPoint presentation will be saved as “Site 

Profiles_site.ppt”. After the file is saved, the presentation is ready for use. To enable the functionality 

of the “Generate PowerPoint Presentation” button, the template for the PowerPoint presentation must 

be saved in the same location as the Site Profiles report.  

 

Converting Site Profiles to Microsoft Word  
We also provide the option to transfer this document from PowerPoint into a Word document. On the 

menu bar from the PowerPoint presentation, select File→Save & Send→Create Handouts. Select the 

most appropriate page layout (options include notes next to slides, blank lines next to slides, notes 

below slides, blank lines below slides, or outline only) and then click OK. Once all the charts have 

been transferred to Word, the file will need to be saved.  

 

Report Distribution  
The Characteristics and Outcomes Site Profiles report is prepared quarterly for each project. This 

report is distributed via e-mail to all agency Data Managers, Principle Investigators, and Program 

Directors each quarter.  

 

Report Accessibility  
The Site Profiles report will be sent out by email. Previous copies of the Site Profiles can be 

requested by contacting your team lead on the Data Management Team at Chestnut Health Systems, 

or e-mailing the Data Management Team at datasubmit@chestnut.org.  

 

Additional information:  
Please review the GAIN-Q3 Scales and Variables file (found at http://gaincc.org/resources) to learn 

more about the items found in the Site Profiles. 

mailto:datasubmit@chestnut.org
http://gaincc.org/resources

